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Chapter 1

Faster Access to the Internet

Faster is always better, right?  In today’s hectic world the answer is usually
“yes”.  However, there is also an economic side to this question which
can’t be ignored.  Let’s look at an example.  A Chevrolet Corvette is faster
than a Chevrolet Geo.  Is the Corvette better?  Probably, but how many
people can afford one?  Internet access is similar.

High-speed T-1, frame-relay and dedicated line access to the Internet is
faster than dial-up analog or even ISDN connections.  Large companies
can certainly afford these types of high speed connections, but individuals
could never justify that expense.

MidPoint has the answer that makes sense, “Modem Teaming”.  MidPoint
can handle more than one connection to the Internet at a time using
affordable analog or ISDN dial-up connections.  By intelligently splitting a
user’s Internet requests over two connections, a request can be serviced far
faster than ever before.

Best of all, MidPoint’s Modem Teaming works with every Internet Service
Provider (ISP) in the world.  You don’t have to wait for new standards to
be approved or for your ISP to upgrade their equipment.  Modem Teaming
is the only answer which works for everyone today!

Ultra-High Speed Connections for Individual Users
A request for even a single web site such as www.cnn.com is handled in a
fraction of the time compared to using a single modem.  This capability is
only enhanced as web sites become more complex being made up of many
pieces.  Perhaps your needs require downloading files.  MidPoint can
download files in half of the time by requesting one piece of the file
through one connection and the other piece of the file through a second
connection.

How many people have two telephone lines at home?  Unless you live on
the banks of a frozen glacier in Antarctica, you probably have at least one
telephone line.  In addition, many people have a second telephone line at
home for a modem, a fax machine or the kids.  After the kids are in bed,
and no one is using either telephone line, pamper yourself by letting
MidPoint increase your bandwidth to the Internet.  Surf the web from
home at twice the speed you’ve ever surfed before.

MidPoint gives you ultra-high speed!

Modem Teaming
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Modem Teaming harnesses two individual connections to the Internet
aggregating their bandwidth to provide unparalleled performance.  The
result of Modem Teaming is that web pages are received far more quickly
than before.  In addition, multiple tasks such as file transfers and web
browsing no longer have to compete for the bandwidth of a single
connection.  This results in better overall performance making use of the
Internet far more enjoyable.

In order to use Modem Teaming, a user must first have at least two
modems and two telephone lines connected to their PC.  One or two dial-
up accounts are required with an ISP.  If your ISP allows multiple
simultaneous logins with the same account, then only one dial-up account
is needed.  Otherwise, a second dial-up account will be necessary.

Modem Teaming makes use of Windows Dial-Up Networking to establish
multiple simultaneous connections to the Internet.  Each connection is
completely independent of the other, each being assigned its own IP
address by the ISP.  From the ISP’s perspective, it appears that there are
multiple individual users connected.  In fact, you can connect to two
different ISPs and still enjoy the benefits of Modem Teaming.

How Does Modem Teaming Work?
In order to understand how Modem Teaming speeds up your web access,
you must first understand a basic concept of web pages.  A user types a
single request into their browser, such as http://www.gm.com.  The result
from that one request will automatically generate additional requests,
typically for all of the graphic images which comprise the web page.  It is
not uncommon for dozens of in-line graphics to be automatically requested.
As an example, let’s look at the General Motors home page.

“In-line”
graphics

Modem Teaming leverages the fact that so many requests are being
generated by the web browser.  As shown in the following diagram,
MidPoint will send some requests over the first connection and some
requests over the second connection.
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In the case of the General Motors home page, over 36 in-line graphic
requests are automatically generated.  Without Modem Teaming, one
modem would have to process all 36 requests by itself.  With a two modem
team, each modem only has to handle 18 requests.  MidPoint doesn’t just
evenly split the number of requests across the number of connections as in
the example above.  MidPoint performs advanced load balancing which
attempts to keep each connection as busy as the others.

Download Doubler
MidPoint’s Download Doubler makes further use of the Modem Teaming
concept.  Since multiple connections are available, file download times are
dramatically reduced by receiving two pieces of a file in parallel.  As an
example, instead of a file taking 10 minutes to receive, the Download
Doubler splits the file into two pieces each taking only 5 minutes to
download.  Because each piece of the file is being received in parallel over
a different connection, the total elapsed time is only 5 minutes.

0 5 minutes 10 minutes

Download
Doubler

One
Connection

How Does Download Doubler Work?
The Download Doubler takes advantage of a feature found in HTTP 1.1
compliant web servers and a feature found in FTP servers called “transfer
restart”.  Each of these features provide the same basic capability, they
allow MidPoint to specify what part of a file to download.

Download Doubler works regardless of whether the request is for a large
graphic image to be displayed on a web page, an HTTP file transfer, or an
FTP file transfer.

From the user’s perspective, they simply make a request from their browser
which is forwarded to MidPoint.  MidPoint then determines if the web or
FTP server processing the request supports HTTP 1.1 or the FTP transfer
restart feature.  If so, the Download Doubler requests the first part of the
file over one connection, and the second part of the file over the second
connection.  If the web or FTP server does not support the required
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features which allow the file to be split, then MidPoint receives the file over
one connection as it would normally have been done.

It is the Download Doubler’s goal to have both pieces of the file completed
at the same time.  In order to accomplish this, the Download Doubler
determines the link speed of each connection that it will be using to receive
the file.  If the link speeds are the same, then the file is basically split in half.
If the link speeds are different, then the Download Doubler will
dynamically determine how big each piece of the file should be. The larger
piece will be requested over the faster connection, the smaller piece over
the slower connection.

It should be noted that the Download Doubler will not split files below a
certain size.  This is because it could actually take longer to perform the
splitting than it would take to receive the file in one piece.  This is due to
the time it takes to establish the second connection and request which part
of the file is needed.  The splitting threshold size is a user adjustable option
within MidPoint.

FailSafe Downloads

It is inevitable with data communications of any kind that you will
experience situations where your connection drops.  The cause of this can
be any number of reasons, however the result has always been lost data.
This is especially frustrating if you are downloading large files.

MidPoint solves this frustration with its FailSafe Downloads feature.  In the
event that a line drop occurs, MidPoint remembers exactly where it was
during the process of retrieving your browser’s requests.  Since MidPoint
sits between your browser and the Internet, your browser is unaware that
the connection had dropped.  MidPoint will then automatically try to
recover the connection by redialing your Internet Service Provider.

If MidPoint is able to recover the connection, it will reissue the requests
and retrieve the information requested by your browser.  The important
item to remember is that your browser will be completely unaware that
MidPoint performed this automatic recovery.

Retaining the Data Already Received

FailSafe Downloads takes advantage of the same technology which
MidPoint employs with its Download Doubler feature.  Web servers
supporting HTTP 1.1 or FTP servers supporting the Transfer Restart
feature allow MidPoint to request only the portions of graphics and file
downloads which remain.  Instead of having to re-retrieve an entire file,
MidPoint retains what has been received to the point of the line drop, and
only needs to get the remainder of the file once the connection has been
recovered.  Of course, if the web server or FTP server does not support the
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required features, MidPoint will have to retrieve the file again in its
entirety.  Either way, this transparent recovery is an exceptional feature.

FailSafe Downloads with Modem Teaming

If you are using MidPoint’s Modem Teaming feature and have multiple
connections to the Internet, MidPoint intelligently shifts requests which
were being processed by the dropped line to one or more of the remaining
connections.  This capability keeps the results coming in to your browser
with little or no delays.

If MidPoint is able to recover the dropped connection in a Modem
Teaming environment, the downloads which had been shifted from the
dropped connection will be returned to the recovered connection.  This
provides the highest possible throughput for your downloads.

As you can see, it’s not magic that makes MidPoint unique, but when you
see Modem Teaming, Download Doubler and FailSafe Downloads in
action, it’s OK to think it’s magic!
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Chapter 2

MidPoint Installation

The MidPoint CD-ROM contains all of the files needed for running
MidPoint on a Windows 95 or Windows NT 4.0-based computer.  During
the installation process, MidPoint SETUP will examine your PC to be sure
that required Windows components are installed.  MidPoint SETUP will
look for TCP/IP and Dial-Up Networking 1.2.  If either of these
components are not found, a warning will be issued in a file named
INSTALL.LOG.  In addition, a record of your installation process will be
written to INSTALL.LOG.

Follow the installation steps listed below:

1.  Place the MidPoint CD-ROM into the CD-ROM drive of your
workstation.

2. Click the Start button and select the Run menu choice.  In the dialog
box provided, type the command:

d:SETUP

You should substitute the actual drive letter of the CD-ROM which is
being used in place of “d:” above.

3.  Follow the instructions as displayed by MidPoint Setup.

4.  After copying all of the MidPoint files to your destination directory,
SETUP will launch MidPoint and walk you through a series of
MidPoint dialog boxes so that you may set any appropriate options.
Pressing the OK button moves you to the next dialog box, pressing
Cancel will terminate the process.

 The dialog boxes that are presented are the same as those you may use
when running MidPoint.  You may change any of these options at any
time in the future when running MidPoint.

5.  The SETUP program creates a MIDPOINT program group in the
Windows Program Manager.  If a MIDPOINT program group already
exists, then any new program icons are placed into it.

6.  MidPoint is designed to run with no user interaction whatsoever.
Therefore, an option is provided to install MidPoint into your Windows
95 or Windows NT 4.0 Startup folder.  This automatically launches
MidPoint when you boot your PC making it available to handle
requests at any time.

Installation of MidPoint is now complete.
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Chapter 3

The File Menu

The File Menu provides two choices: Clear and Exit.  Clear provides a
cascading menu with additional choices (described below).

Exit Alt+F4

File

Clear

Reset Connection

MidPoint Log
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File Menu: Clear

Choose Clear when you want to empty the contents of MidPoint’s activity
log.  Clear is also used to Reset Connections if necessary.

Select Clear, and a cascaded menu appears with two options.  This is
where you specify what Clear action should take place.

• MidPoint Log - Select this option to clear the contents of
MidPoint’s activity log.  MidPoint maintains a log of when it
starts up and shuts down, establishes and terminates
connections to the Internet, and all activity which takes place
while connected to the Internet.

The log is maintained on a daily basis and is named accordingly.
For example, the MidPoint log for January 31, 1997 is named
97-01-31.LOG.  At midnight, MidPoint will close its current
log and create a new log which reflects the new date.  Since the
log records a great deal of activity, it is possible that it can get
quite large.  MidPoint will keep logs for the current day and
two previous days.  Older logs are automatically deleted.

• Reset Connection - Select this option to reset the currently
selected activity in MidPoint’s Status Pane.  This option has the
effect of canceling a request made by a user.  Typically a user
would simply press the Stop button on their browser to cancel a
request.

File Menu: Exit

Choose Exit to shut down MidPoint.  MidPoint will provide a warning if it
has open connections or if it is processing any requests when you selected
Exit.

The Alt-F4 keystroke is available as an accelerator key to issue the Exit
command.
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Chapter 4

The View Menu

The View Menu provides options to see more information about
MidPoint’s activity log or various user-definable settings.  These
capabilities are described in more detail below.

MidPoint Log

View

Options...

Stay on Top
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View Menu: MidPoint Log

Choose MidPoint Log when you want to review an activity log of events
for MidPoint.  MidPoint will launch the Windows NotePad application and
display its activity log within NotePad.

MidPoint maintains a log of when it starts up and shuts down, establishes
and terminates connections to the Internet, and all activity which takes
place while connected to the Internet.

The log is maintained on a daily basis and is named accordingly.  For
example, the MidPoint log for January 31, 1997 is named 97-01-31.LOG.
At midnight, MidPoint will close its current log and create a new log which
reflects the new date.  Since the log records a great deal of activity, it is
possible that it can get quite large.  MidPoint will keep logs for the current
day and two previous days.  Older logs are automatically deleted.

View Menu: Stay on Top

Choose Stay on Top to keep the MidPoint window visible in the
foreground.  This is useful if you wish to monitor activity within MidPoint
while working on other applications.

Once Stay on Top has been selected, a check mark is placed beside the
text Stay on Top to indicate that MidPoint will remain in the foreground.
To return to normal operation, simply choose Stay on Top again to
deselect it.

View Menu: Options

Choose Options in order to review or set any of the user-definable options
within MidPoint.  These options allow you to customize your copy of
MidPoint.

Once Options has been selected, the user is presented with a tabbed dialog
box.  Each tab within the dialog box has a number of settings which define
MidPoint’s personality.  Each option is described in more detail below.
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View Menu: Options|Doubler

MidPoint’s Modem Teaming has the ability to dramatically reduce the time
it takes to download.  By using two connections, one to download one part
of a file and the second to download the other part of the file, file transfers
and/or the receipt of large graphic images will occur in about half of the
time it would take through a single connection.  This feature is called the
Download Doubler.

The Doubler tab is divided into two groups, “Download Doubler” and
“Download Doubler Options”.  The following is displayed when the
Doubler tab is active on the Options dialog box.

Enable Download Doubler
This checkbox should normally be checked.  This enables MidPoint’s
Download Doubler feature to automatically split file transfers and large
files when you have multiple connections to the Internet active.

Use Download Doubler for HTTP
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The Download Doubler works by requesting portions of the file to be
transferred when communicating with a web server using the HTTP
protocol.  Having this checkbox selected will enable this support.

Use Download Doubler for FTP
The Download Doubler works by requesting portions of the file to be
transferred when communicating with an ftp server using the FTP protocol.
Having this checkbox selected will enable this support.

Minimum File Size __ KB
Specify the minimum size of a file (in kilobytes) that should be split by the
Download Doubler.  In order to split the file, two requests are made to the
HTTP or FTP server.  It is better to receive smaller files through a single
connection as the processing to establish the second request to the server
can sometimes take several seconds.  A minimum file size of 98KB is
recommended.

Don’t split if size < __ times connect speed
Specify the multiple of your connect speed that the Download Doubler
should use to determine if it should split a file.  Typically, files that are
smaller than 2 times your connect speed should not be split by the
Download Doubler.  Doing so can take additional time processing that
could take as long or longer than simply downloading the file through a
single connection.

Maximum Size to Split __ KB
Specify the maximum size of a file (in kilobytes) that should be split by the
Download Doubler.  As the two sections of a file are being received,
MidPoint passes the first portion immediately onto your browser.  The
second portion of the file is retained by MidPoint until such time that the
browser has completely received the first portion of the file.  Allowing
extremely large files to be split means that MidPoint must retain half of that
file at any one time requiring storage in order to do so.  If multiple users
are splitting files at one time, the amount of storage that MidPoint may
require can become large.

Adjustment for connect time __ KB
Specify the size (in kilobytes) of adjustment that the Download Doubler
should use to account for the delay in establishing the second portion of the
transfer.  The goal of the Download Doubler is to complete receiving both
the first portion and the second portion of the file at the same time.  After
initiating the receipt of the first portion of the file, MidPoint establishes a
second connection to the server and requests the second portion of the file.
An adjustment must be made to account for the amount of the first portion
of the file which will be received while the request for the second portion is
in progress.
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View Menu: Options|Ports

The Ports dialog box allows you to change MidPoint’s default settings for
HTTP and FTP ports.  You may have particular needs which require
MidPoint to either listen to or send to a TCP port other than the standard
port defaults.  If this is the case, the Ports dialog box allows you to alter
the TCP ports that MidPoint uses for listening and sending.

Type
The Type column lists the protocol type (HTTP, HTTP Secure or FTP).
The checkbox to the left of the protocol determines whether or not
MidPoint will allow requests for that specific protocol.  If you do not want
MidPoint to support a particular protocol, simply uncheck the checkbox
next to that particular protocol.

Inbound Port
The value specified in the Inbound Port field is the TCP port which
MidPoint will listen to for the particular protocol.  This value is associated
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with the port that the user’s application uses.  For example, by default, a
web browser sends requests to port 80.  Therefore, MidPoint will need to
be listening on port 80 in order to receive the request from the web
browser.

HTTP Secure and FTP Inbound Ports use the same Inbound Port specified
for HTTP.  For this reason, you cannot change the values of these ports.

Outbound Port
The value specified in the Outbound Port field is the TCP port which
MidPoint will use to send a request for the particular protocol.  This value
is associated with the port that the destination server uses.  For example,
by default, a web server listens for requests on port 80.  Therefore,
MidPoint will need to send the request on port 80 in order for the web
server to properly receive the request.
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Chapter 5

The Connect Menu

The Connect Menu provides options to specify the Dial-Up Networking
connection and a variety of managed dialing choices.  These capabilities are
described in more detail below.

Settings...

Connect

Hangup Line 1
Dial Line 2
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Connect Menu: Settings…

Choose Settings in order to review or set the Dial-Up Networking
connection and any of the managed dialing options.

Once Settings has been selected, the user is presented with a tabbed dialog
box.  Each tab within the dialog box represents the connection settings for
a particular line.  Each option is described in more detail below.
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Connect Menu: Settings|Line 1

MidPoint uses the standard Windows 95 and Windows NT Dial-Up
Networking and Dial-Up Scripting facilities for establishing the connection
for Line 1 to your Internet Service Provider.

The Line 1 tab is divided into three groups, “Connection”, “Dialing” and
“Duration”.  The following is displayed when the Line 1 tab is active on the
Settings dialog box.

Specify a Dial-Up Networking Connection for Line 1
This drop down list box contains the names of all Dial-Up Networking
connections that have been defined to Windows 95 or Windows NT 4.0.
Select the appropriate choice to be used as the primary means for
connecting to the Internet.

Add…
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Click this button to invoke the Windows 95 or Windows NT “Make a New
Connection” wizard.  This will walk you through the steps of adding a new
Dial-Up Networking connection.

Properties…
Click this button if you want to review or change the settings for the
currently selected Dial-Up Networking connection.  You will be placed
into the standard Windows 95 or Windows NT dialog boxes for reviewing
a Dial-Up Networking connection.

Connect When Launched
This checkbox should be selected if you want MidPoint to connect to the
Internet immediately after being launched.  This option is helpful if
MidPoint has been placed into the Startup folder to be automatically
launched when Windows 95 or Windows NT is invoked.

Connect Upon Request from Application
This checkbox should be selected if you want MidPoint to automatically
connect to the Internet if a request is received from an application.  This is
a commonly used feature which eliminates the need for anyone to manually
connect and disconnect from the Internet.

MidPoint senses a request from an application and looks to see if an
Internet connection is already established. If this checkbox is checked and
no Internet connection currently exists, MidPoint will immediately establish
the connection.

Try Dialing up to ___ Times to Connect
This checkbox should be selected if you want MidPoint to make multiple
attempts to connect to the Internet.  Specify a value of the number of times
that MidPoint should attempt the connection.  Valid values are 1-9.

This option is useful if you often encounter busy signals when trying to
connect to your Internet Service Provider.



Page 19

Disconnect if Idle for ___ Minutes
This checkbox should be selected if you want MidPoint to terminate the
connection to the Internet after a specified period of inactivity.  Specify the
number of minutes MidPoint should wait before it disconnects from the
Internet.  Valid values are 1-99 minutes.

This option is useful if your Internet Service Provider charges you based
upon how long you have been connected.

Re-dial if Disconnected
This checkbox should be selected if you want MidPoint to attempt to
reestablish a connection to the Internet if the line drops after you have
connected.

Re-dial Failed Call Every ___ Minutes
This checkbox should be selected if you want MidPoint to persistently
attempt to connect if it had previously been unable to establish the
connection.  Specify the number of minutes MidPoint should wait before it
attempts to establish the connection again.

This option is useful if your modem allows you to place calls or pick up
incoming calls while it is connected.  The modem will disconnect the data
connection and allow you to handle your voice call.  MidPoint will
periodically test the line to see if it is free so that your connection to the
Internet may be re-established.
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Connect Menu: Settings|Line 2

The Line 2 tab is divided into three groups, “Connection”, “Dialing” and
“Duration”.  Many of the options are the same as those found on the Line 1
tab, however you will find several new options in the Dialing groupbox.
The following is displayed when the Line 2 tab is active on the Settings
dialog box.

Specify a Dial-Up Networking Connection for Line 2
This drop down list box contains the names of all Dial-Up Networking
connections that have been defined to Windows 95 or Windows NT 4.0.
Select the appropriate choice to be used as a secondary means for
connecting to the Internet.

Add…
Click this button to invoke the Windows 95 or Windows NT “Make a New
Connection” wizard.  This will walk you through the steps of adding a new
Dial-Up Networking connection.
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Properties…
Click this button if you want to review or change the settings for the
currently selected Dial-Up Networking connection.  You will be placed
into the standard Windows 95 or Windows NT dialog boxes for reviewing
a Dial-Up Networking connection.

Connect in Parallel with Line 1
This checkbox should be selected if you want MidPoint to establish a
second connection to the Internet as soon as the connection for Line 1 has
been established.  This is useful for gaining the maximum performance even
if only one user is actively using MidPoint.

When Connect in Parallel with Line 1 is used, MidPoint will always insure
that this secondary connection matches Line 1’s connectivity.  If Line 1 is
disconnected because it has been idle, then Line 2 will be disconnected as
well.  If Line 2 is dropped for any reason and Line 1 remains active, Line 2
will be reconnected.

Connect if Line 1 Connection Drops
This checkbox should be selected if you want MidPoint to automatically
connect to the Internet using the secondary line in the event that the
primary connection has failed and cannot be reestablished.

Connect if ___ Requests are Queued
This checkbox should be selected if you want MidPoint to establish a
secondary connection only when the primary connection is backlogged
with requests.  Specify the number of outstanding requests that must be
queued before the secondary line should be connected.  Valid values are 1-
99.

This option is useful if are trying to keep expenses low by using the
secondary line (and therefore the secondary Internet Service Provider
account) only when there is a heavy usage.

Try Dialing up to ___ Times to Connect
This checkbox should be selected if you want MidPoint to make multiple
attempts to connect to the Internet.  Specify a value of the number of times
that MidPoint should attempt the connection.  Valid values are 1-9.  This
option is useful if you often encounter busy signals when trying to connect
to your Internet Service Provider.
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Disconnect if Idle for ___ Minutes
This checkbox should be selected if you want MidPoint to terminate the
connection to the Internet after a specified period of inactivity.  Specify the
number of minutes MidPoint should wait before it disconnects from the
Internet.  Valid values are 1-99 minutes.

This option is useful if your Internet Service Provider charges you based
upon how long you have been connected.

Re-dial if Disconnected
This checkbox should be selected if you want MidPoint to attempt to
reestablish a connection to the Internet if the line drops after you have
connected.

Re-dial Failed Call Every ___ Minutes
This checkbox should be selected if you want MidPoint to persistently
attempt to connect if it had previously been unable to establish the
connection.  Specify the number of minutes MidPoint should wait before it
attempts to establish the connection again.

This option is useful if your modem allows you to place calls or pick up
incoming calls while it is connected.  The modem will disconnect the data
connection and allow you to handle your voice call.  MidPoint will
periodically test the line to see if it is free so that your connection to the
Internet may be re-established.
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Connect Menu: Dial/Hangup Line 1

This menu choice will read either Dial Line 1 if Line 1 is not yet connected
or it will read Hangup Line 1 if Line 1 is already connected.  MidPoint
will dial or hangup immediately if so instructed.  Caution should be
exercised when initiating a hangup since you could cause outstanding user
requests to be lost.

As an alternative to using this menu choice, MidPoint will display one of
the following pop-up windows if you right-click the mouse anywhere
within MidPoint’s Status Pane.  You may also access these pop-ups when
MidPoint is minimized in the system tray.  This is accomplished by right-
clicking on the MidPoint icon in the system tray.

The Line 1-only pop-up is displayed if you have not defined a second line
to MidPoint.  The Line 1/Line 2 pop-up is displayed if two lines have been
defined to MidPoint.

Connect Menu: Dial/Hangup Line 2

This menu choice will read either Dial Line 2 if Line 2 is not yet connected
or it will read Hangup Line 2 if Line 2 is already connected.  MidPoint
will dial or hangup immediately if so instructed.  Caution should be
exercised when initiating a hangup since you could cause outstanding user
requests to be lost.

As documented above, the alternate pop-up window can be used if you
have Line 2 defined.
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Chapter 6

The Help Menu

The Help Menu provides information about MidPoint.  Access to
MidPoint’s help screens and the “About Box” are available here.

About MidPoint...

Help

General Help
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Help Menu: General Help

MidPoint’s Help is provided as a series of HTML documents.  This allows
Help to be easily viewed or printed from your favorite web browser.

From the MidPoint folder which was created during SETUP, double-click
on the icon associated with any of the on-line documentation.  Several
documents are available to you.  These include:

• MidPoint Teamer User’s Guide(TEAMHELP.HTM)
 This document provides instructions on MidPoint, including

installation, configuration and usage.

• MidPoint Teamer FAQ (TEAMFAQ.HTM)
 This document provides a series of Frequently Asked Questions

(FAQs) specifically related to MidPoint.
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Help Menu: About Box

The About Box provides the version number of MidPoint that you are
running.  This will be important if you should ever need to contact
technical support.  In addition, the About Box contains copyright
information regarding MidPoint.
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Chapter 7

Running MidPoint

MidPoint can be invoked using any standard method for starting an
application within Windows 95 or Windows NT.  Windows 95 and
Windows NT 4.0 users commonly invoke MidPoint by clicking the Start
button and selecting MidPoint from the Programs list.

Auto-start MidPoint
Since MidPoint will dial and manage your connections, you may find it
desirable to place MidPoint into the Startup folder on your PC.

Auto-connecting to the Internet
Typically, most users have MidPoint configured so that the connection to
the Internet requires no user interaction whatsoever.  MidPoint
automatically establishes the connection when needed, logs in to your ISP
and begins communicating to the Internet.

In the event that you have specified a Dial-Up Networking connection to
MidPoint which does not have a User ID and Password, MidPoint will
display the following dialog box.

After providing the requested information, MidPoint provides this
information to Dial-Up Networking so that your connection to the Internet
can be established.  If the Save Password checkbox is selected, MidPoint
instructs Windows to save this information for you in its password list.
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MidPoint in Action

When MidPoint is running, it is often kept minimized in the System Tray.
This is because no interaction is required between the user and MidPoint.
As described previously in this documentation, MidPoint can be set up to
automatically connect to the Internet when it receives a request from a
user, and it will automatically disconnect after a period of inactivity.

Status Pane Information
If you want to look at MidPoint while it is running, you will see a very
simple user interface.  Within the Status Pane, you will see:

• Who is requesting connections

• Where the connections are being established

• What command is being issued

• Results or status of the command that was issued

The following screen shot shows an example of the type of information
which is displayed by MidPoint.  When using MidPoint’s support for
multiple connections to the Internet, you will note that each connection is
displayed as a different color.  This helps to easily identify the fact that
multiple connections are in use.

SpeedBar Information
MidPoint’s SpeedBar is displayed in the same area which is used for
presenting textual Status information.  The SpeedBar provides a graphical
representation of the current throughput MidPoint is experiencing.  This is
real-time information which is updated, by default, every three seconds.

If Modem Teaming is being used, the SpeedBar is subdivided showing the
relative performance that each connection is receiving as part of the total
performance.  This is shown using the same colors used for the text in the
Status Pane.
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By right-clicking your mouse button within the SpeedBar area, a pop-up
window will let you turn-off this feature, select to display upload versus
download performance, or alter the refresh time.

Detail Pane Information
You can get even more detail about a particular request.  This is
accomplished by simply clicking on an active line in the Status Pane.  The
Detail Pane will immediately be displayed (if it is not already on your
screen).  The following is an example of the Detail Pane.

The Detail Pane is a scrollable window which shows the specifics about the
request such as the protocol (e.g. HTTP, FTP, Telnet, etc.), the actual
command which was issued to the remote server, the Status received back
from the remote server, and a result count if information is actively being
transferred from the remote server.

Connection ControlBox
MidPoint provides a quick mechanism to dial or hang-up connections
called the Connection ControlBox.  MidPoint will display one of the
following pop-up windows if you right-click the mouse anywhere within
MidPoint’s Status Pane.  You may also access the Connection ControlBox
when MidPoint is minimized in the system tray.  This is accomplished by
right-clicking on the MidPoint icon in the system tray.

The Line 1-only pop-up is displayed if you have not defined a second line
to MidPoint.  The Line 1/Line 2 pop-up is displayed if two lines have been
defined to MidPoint.

Simply click on the raised button to invoke that function.  If the upper
image (showing the telephone off-hook) is in the raised state, clicking it
will cause MidPoint to establish that connection.  If the lower image
(showing the telephone on-hook) is raised, clicking it will cause MidPoint
to disconnect that connection.
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Chapter 8

Accessing MidPoint Functions

MidPoint provides a number of functions which are accessible through
your web browser.  In order to access the MidPoint Functions, simply type
the URL “midpoint” within your browser and press enter.  You will be
presented with the following:

Visit Boca Research’s Web Site
Click this button to go to the Boca Research web site.  You will find
information about MidPoint, new versions and special offers.

View Connection Status
Click this button to display the status of MidPoint’s connections.  MidPoint
will report the online/offline connection status for each port and
usage/performance statistics for each port.

View On-Line Documentation
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Click this button to display a screen containing all of the available MidPoint
documentation which can be viewed on-line.  The user can then click on
the specific document that they wish to review in their browser.

Support Functions
Click this button to display a screen containing a variety of support
functions such as reviewing MidPoint’s Install Log, Activity Log,
Initialization File and Tracing information.  This information may be
requested if you contact technical support for assistance.


